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Copyright Notices
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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (www.hp.com/
managementsoftware/svi_partner_list), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web 
site and use the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products 
formerly produced by Mercury, we encourage you to visit the Mercury Customer Support 
Web site at: http://support.mercury.com.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at:

www.hp.com/managementsoftware/services 

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract. To find more information about access levels, go to: 
www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to: 
www.managementsoftware.hp.com/passport-registration.html
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Welcome

Welcome to HP Enterprise Integration module for SAP solutions, which 
integrates SAP Solution Manager with Quality Center. Using Enterprise 
Integration, you can export SAP Solution Manager business blueprints to the 
Quality Center Requirements module. You can then design and run tests in 
Quality Center based on these requirements and update Solution Manager 
with their results.

In addition, when you install Enterprise Integration, the Application Model 
module is installed. You can import the application entity hierarchy from 
your SAP application to the Application Model module, enabling you to use 
the Application Model module to model your SAP application within 
Quality Center. You can then associate entities in the Application Model 
module with Quality Center tests and business components, enabling you 
to plan your testing process based on the application entity hierarchy.

Note: This guide explains how to work with SAP Solution Manager in 
conjunction with Quality Center. For more information on using 
Quality Center, refer to the HP Quality Center User’s Guide. For more 
information on using Solution Manager, refer to the Solution Manager 
documentation.
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Welcome
Using This Guide

This guide contains the following chapters:

Chapter 1 Setting Up Enterprise Integration

Describes how to install and enable Enterprise Integration.

Chapter 2 The Enterprise Integration Workflow

Describes the steps performed when using Enterprise Integration to work 
with Solution Manager and Quality Center.

Chapter 3 Working with Enterprise Integration

Describes how to import Solution Manager business blueprints in 
Quality Center and how to update Solution Manager with test results from 
Quality Center.

Chapter 4 Working with the Application Model Module

Describes how to import and manage application entities in the Application 
Model module.

Chapter 5 Customizing Enterprise Integration

Describes how to customize permissions and project entities for Enterprise 
Integration.
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Welcome
Typographical Conventions

This guide uses the following typographical conventions:

UI Elements and 
Function Names

This style indicates the names of interface elements on 
which you perform actions, file names or paths, and 
other items that require emphasis. For example, “Click 
the Save button.” It also indicates method or function 
names. For example, "The wait_window statement has 
the following parameters:"

Arguments This style indicates method, property, or function 
arguments and book titles. For example, “Refer to the 
HP User’s Guide.”

<Replace Value> Angle brackets enclose a part of a file path or URL 
address that should be replaced with an actual value. 
For example, <MyProduct installation folder>\bin.

Example This style is used for examples and text that is to be 
typed literally. For example, “Type Hello in the edit 
box.”

CTRL+C This style indicates keyboard keys. For example, “Press 
ENTER.”

[ ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument. 

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. In a 
programming example, an ellipsis is used to indicate 
lines of a program that were intentionally omitted.

| A vertical bar indicates that one of the options 
separated by the bar should be selected.
9
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1
Setting Up Enterprise Integration

This chapter describes the installation requirements and setup procedures 
for using Enterprise Integration.

This chapter describes: On page:

Requirements for Enterprise Integration 12

The Installation Process 12

Installing Enterprise Integration 14

Loading the Enterprise Integration License 25

Enabling the Enterprise Integration Extension 26

Installing the SAP Application Importer Component 28

Uninstalling Enterprise Integration 29
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Chapter 1 • Setting Up Enterprise Integration
Requirements for Enterprise Integration

To use Enterprise Integration, you must have the following installed:

➤ Quality Center 9.2 (on your server machine)

➤ Quality Center 9.2 Patch 7 (on your server machine)

➤ SAP Solution Manager 4.0 Service Pack 12 with note ID 1065377 or later

The minimum system requirements to run Enterprise Integration are the 
same as for Quality Center, as described in the HP Quality Center Installation 
Guide. In addition, to push a Solution Manager business blueprint 
containing content in a particular language, the Quality Center server 
machine must be installed on an operating system that supports that 
language.

The Installation Process

This section describes the Enterprise Integration installation process.

To install Enterprise Integration:

 1 Ensure that Quality Center 9.2 is installed on your server machine.

For more information on installing Quality Center, refer to the 
HP Quality Center Installation Guide.

 2 Install Quality Center 9.2 Patch 7 on your server machine.

Quality Center 9.2 Patch 7 is provided on the Enterprise Integration 
installation CD. To install the patch, follow the on-screen installation 
instructions.

 3 Install the Enterprise Integration on your server machine.

For more information on installing the Enterprise Integration, see 
“Installing Enterprise Integration” on page 14.

 4 Load the Enterprise Integration license.

For more information, see “Loading the Enterprise Integration License” on 
page 25.
12



Chapter 1 • Setting Up Enterprise Integration
 5 Enable the Enterprise Integration extension in Quality Center Site 
Administration for every project that requires Enterprise Integration.

For more information, see “Enabling the Enterprise Integration Extension” 
on page 26.

 6 Install the SAP Application Importer Component on each client machine.

The Application Model module is installed automatically when you install 
Enterprise Integration. To import application entities from your SAP 
application to the Application Model module, the SAP Application Importer 
Component must be installed on each client machine from which you want 
to import application entities. For more information on installing the SAP 
Application Importer Component, see “Installing the SAP Application 
Importer Component” on page 28.
13



Chapter 1 • Setting Up Enterprise Integration
Installing Enterprise Integration

To install Enterprise Integration, you download the installation files from 
the HP Quality Center Add-ins page and run the installation wizard.

To install Enterprise Integration:

 1 Open your Web browser and type your HP Quality Center URL: 
http://<Quality Center server name>[<:port number>]/qcbin. The 
HP Quality Center Options window opens.

 2 Click the Add-ins Page link. The HP Quality Center Add-ins page opens.
14



Chapter 1 • Setting Up Enterprise Integration
 3 Click the More HP Quality Center Add-ins link. The More HP Quality Center 
Add-ins page opens.

 4 Under Quality Center Administrator Add-ins, under SAP Add-ins, click the 
HP Enterprise Integration module for SAP solutions link. The HP Enterprise 
Integration module for SAP solutions page opens.

 5 Right-click the Download Enterprise Integration link for your platform and 
click Save Target As. The Save As dialog box opens.

 6 In the Save As dialog box, select a location on your Quality Center server 
machine to save the installation file and click Save.

 7 From your Quality Center server machine, run the appropriate installation 
file.

 8 The Welcome dialog box opens. Click Next.

Platform To install:

Windows Run the setup.exe file.

Solaris or Linux
(console mode)

➤ To install on a Solaris platform, type:
./solv4_setup -console 

➤ To install on a Linux platform, type:
./linux_setup -console

Solaris or Linux
(UI mode)

Make sure that the DISPLAY environment variable is 
properly configured on the Quality Center host machine, 
and that the machine from which you are installing is 
running an X-server (for example, Exceed). 

➤ To install on a Solaris platform, type:
./solv4_setup.bin

➤ To install on a Linux platform, type:
./linux_setup.bin
15



Chapter 1 • Setting Up Enterprise Integration
 9 The License Agreement dialog box opens.

Read the license agreement. To accept the terms of the license agreement, 
select I accept the terms of the license agreement.

Click Next.
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Chapter 1 • Setting Up Enterprise Integration
 10 The Directory Name dialog box opens.

Accept the proposed folder for the Enterprise Integration installation or 
browse for an alternate folder.

Click Next.
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 11 The HP Quality Center Repository Path dialog box opens.

Type the location of the Quality Center repository.

Click Next.
18



Chapter 1 • Setting Up Enterprise Integration
 12 The Installation Summary dialog box opens.

To review or change any settings, click Back.

To accept the settings and start the installation, click Next. The installation 
process starts.
19



Chapter 1 • Setting Up Enterprise Integration
 13 When the installation process completes, the Update Server dialog box 
opens.

When you update the Quality Center server, the Enterprise Integration files 
are copied into the opened archive directories (qcbin.war and sabin.war) in 
the <Quality Center Installation>\application directory. In addition, two 
new open archive directories are added: 30QCToSM.ear and 
40SMToQCIntegration.war. The Quality Center Archive and Deployment 
Tool is launched. This tool enables you to update the running 
Quality Center Web server.

Select an update option:

➤ Update now. To update the Quality Center archive files and launch the 
deployment tool now.

➤ Update later. To manually update the Quality Center server at a later 
time. You must update the Quality Center server before you can use 
Enterprise Integration.

Click Next. 
20



Chapter 1 • Setting Up Enterprise Integration
 14 If you selected Update now, proceed to step 15.

If you selected Update later, click Next and then click Finish to close the 
installation setup dialog box. When you are ready to update the application 
server, run the deploy.bat script (or deploy.sh for Solaris or Linux) from the 
<Enterprise Integration installation> directory. When running the batch file, 
specify the Quality Center installation directory and the location of the 
Quality Center repository, using the format:

deploy <Quality Center installation directory> <Quality Center repository 
directory>

For example:

deploy "C:\Program Files\Mercury\Quality Center" "C:\Program 
Files\Mercury\Quality Center\repository"

 15 After clicking Update now or manually launching the batch file, the 
Quality Center Archive and Deployment Tool opens.
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Chapter 1 • Setting Up Enterprise Integration
For Enterprise Integration to work with Quality Center, you need to create a 
new archive and redeploy the qcbin.war, sabin.war, 30QCToSM.ear, and 
40SMToQCIntegration.war files on the application server. This enables 
changes to the archive files to take effect. Note that it takes more time to 
create qcbin.war than sabin.war.

Click Next to create the new archive files.

 16 If your application server is JBoss, proceed to step 17.

If your application server is other than JBoss, the following dialog box 
opens.

You must deploy Quality Center manually on the application server after 
the setup process completes. The location of the archive files is shown in the 
dialog box. 
22



Chapter 1 • Setting Up Enterprise Integration
The updated archive files are stored in different formats, although the 
content is the same. The files are stored openly in the 10sabin.war, 
20qcbin.war, 30QCToSM.ear, and 40SMToQCIntegration.war folders, and as 
closed archives in sabin.war, qcbin.war, 30QCToSM.ear, and 
40SMToQCIntegration.war. You must also create manually a JMS queue 
named mercury/spi/jms.

Note: For more information on manually deploying Quality Center on an 
application server, refer to the HP Quality Center Installation Guide.

Click Next and proceed to step 19.

 17 If your application server is other than JBoss, proceed to step 19.

If your application server is JBoss, the HP Quality Center Redeployment 
dialog box opens.
23
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Choose one of the following options:

➤ Yes. To deploy the archive files automatically.

➤ No. To manually deploy the archive files later.

Click Next.

 18 If the Quality Center service is running, the Archive and Deployment Tool 
automatically attempts to stop the service. If the tool is unable to stop the 
service, the Service not stopped dialog box opens.

Choose one of the following options:

➤ Retry. To try again to stop the JBoss service.

➤ Skip JBoss deployment. To cancel the deployment and manually deploy 
JBoss later.

Click Next.
24



Chapter 1 • Setting Up Enterprise Integration
 19 When the deployment is complete, the Completion dialog box opens. Click 
Finish to close the Quality Center Archive and Deployment Tool.

Note: If you manually deployed the archive files on your application server, 
you must restart Quality Center after deployment. 

 20 Click Finish to close the HP Quality Process for SAP Solutions Setup dialog 
box.

Loading the Enterprise Integration License

To enable the Services module in Quality Center, you must load your 
Enterprise Integration license.

To load the Enterprise Integration license:

 1 In Site Administration, click the Licenses tab.
25



Chapter 1 • Setting Up Enterprise Integration
 2 Click the Modify License button. The License Edit dialog box opens.

 3 Click the Load License button and select the Enterprise Integration license 
file. Alternatively, copy the license file and click Paste License.

 4 Click OK. The license is displayed in the list of licenses.

Enabling the Enterprise Integration Extension

After installing Enterprise Integration on your Quality Center server, you 
must enable the Enterprise Integration extension for a project before you 
can use it with the project. 

Notes:

➤ You cannot disable an extension for a project after you enable it.

➤ When you enable a project for Enterprise Integration, the Application 
Model module and associated features are also enabled for the project.

➤ If the project is active, you must deactivate it before enabling an 
extension. After the extension has been enabled, you can reactivate the 
project.

➤ Enabling extensions for a project can take some time.
26



Chapter 1 • Setting Up Enterprise Integration
To enable the Enterprise Integration extension for a project:

 1 In Quality Center Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, click the Project 
Extensions tab. The Extensions list is displayed, listing extensions installed 
on the Quality Center server for which you have a license.

 3 Select the Enabled check box for the Enterprise Integration for SAP 
applications extension, and click Yes to confirm. The Enterprise Integration 
for SAP applications and Application Model extensions are both enabled 
and a confirmation message displays.
27



Chapter 1 • Setting Up Enterprise Integration
Installing the SAP Application Importer Component

You must install the SAP Application Importer Component on each 
Quality Center client machine on which you want to import SAP 
application entity hierarchies to the Application Model module, which is 
installed with Enterprise Integration. The SAP Application Importer 
Component is the tool that communicates with the SAP server and imports 
application entity data from your SAP application to Quality Center.

Notes: 

➤ To install the SAP Application Importer Component, you must have 
Microsoft .NET Framework 2.0 installed on the client machine. You can 
download these from the Microsoft Web site 
(http://www.microsoft.com).

➤ To install the SAP Application Importer Component, you must have 
administrator permissions on the client machine.

To install the SAP Application Importer Component:

 1 From your Quality Center client machine, log in to a project for which 
Enterprise Integration is enabled. The SAP Application Importer Component 
files are downloaded to your client machine.

 2 Locate the APM directory in the Quality Center installation directory (by 
default C:\Program Files\Common Files\Mercury 
Interactive\Quality Center).

 3 Run the SAPinspectorSetup.exe file located in this folder and follow the 
installation instructions on your screen.
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Chapter 1 • Setting Up Enterprise Integration
Uninstalling Enterprise Integration

This section describes how to uninstall Enterprise Integration from your 
Windows, Solaris, or Linux server machine. When you uninstall Enterprise 
Integration, the Enterprise Integration files are deleted from Quality Center.

This section includes the following topics:

➤ Uninstalling Enterprise Integration from Windows

➤ Uninstalling Enterprise Integration from Linux or Solaris

Uninstalling Enterprise Integration from Windows
This section describes how to uninstall Enterprise Integration from 
Windows.

To uninstall Enterprise Integration from Windows:

 1 Make sure that the application server is running.

 2 To open the HP Quality Process for SAP Solutions Uninstall dialog box, you 
can:

➤ Choose Start > Settings > Control Panel > Add/Remove Programs, select 
HP Quality Process for SAP Solutions, and click the Change/Remove 
button. Follow the instructions on your screen.

➤ Locate the Enterprise Integration home directory. By default, the files are 
stored in [drive]:\Program Files\Mercury\Quality Process for SAP Solutions. 
In the _uninst subdirectory, double-click uninstall.exe.

The HP Quality Process for SAP Solutions Uninstall dialog box opens.
29



Chapter 1 • Setting Up Enterprise Integration
 3 Click Next. The Update the server dialog box opens.

Select an update option:

➤ Yes. To update the archive files and launch the deployment tool now.

➤ No. To update and uninstall later.

Click Next to continue to uninstall, or Cancel to uninstall later.
30



Chapter 1 • Setting Up Enterprise Integration
 4 The Quality Center Archive and Deployment Tool opens.

To uninstall Enterprise Integration, you need to create a new archive and 
redeploy the Quality Center and Site Administration war files (qcbin.war 
and sabin.war) on the application server. This enables changes to the .war 
files to take effect. If your application server is JBoss, the files are redeployed 
automatically. Otherwise, you must redeploy the files manually.

Click Next to create the new archive files.

Note: It takes more time to create qcbin.war than sabin.war.
31



Chapter 1 • Setting Up Enterprise Integration
 5 If your application server is JBoss, proceed to step 6.

If your application server is other than JBoss, the following dialog box 
opens.

You must deploy Quality Center manually on the application server after 
the setup process completes. The location of the archive files is shown in the 
dialog box. 

The updated archive files are stored in different formats, although the 
content is the same. The files are stored openly in the 10sabin.war and 
20qcbin.war folders, and as closed archives in sabin.war and qcbin.war.

To update the archives and undeploy them manually, run the undeploy.bat 
script (or undeploy.sh for Solaris or Linux) from the <Enterprise Integration 
installation> directory. When running the batch file, specify the 
Quality Center installation directory and the location of the Quality Center 
repository, using the format:

undeploy <Quality Center installation directory> <Quality Center repository 
directory>
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For example:

undeploy "C:\Program Files\Mercury\Quality Center" "C:\Program 
Files\Mercury\Quality Center\repository"

You must also manually updeploy QCToSM.ear and 
SMToQCIntegration.war.

Note: For more information on manually deploying Quality Center on an 
application server, refer to the HP Quality Center Installation Guide.

Click Next and proceed to step 8.

 6 If your application server is other than JBoss, proceed to step 8.

If your application server is JBoss, the HP Quality Center Redeployment 
dialog box opens.
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Choose one of the following options:

➤ Yes. To deploy the archive files automatically.

➤ No. To manually deploy the archive files later. 

Click Next to continue.

 7 If the Quality Center service is running, the Archive and Deployment Tool 
automatically attempts to stop the service. If the tool is unable to stop the 
service, the Service not stopped dialog box opens.

Choose one of the following options:

➤ Retry. To try again to stop the JBoss service.

➤ Skip JBoss deployment. To cancel the deployment and manually deploy 
JBoss later.

Click Next.
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Chapter 1 • Setting Up Enterprise Integration
 8 When the deployment is complete, the Completion dialog box opens. Click 
Finish to close the Quality Center Archive and Deployment Tool Setup. The 
HP Quality Process for SAP Solutions Uninstall dialog box is displayed.

 9 Click Next. The Update completed dialog box opens.

 10 Click Next to continue. The File Deletion dialog box opens.

It is recommended that you click Yes to delete the remaining uninstall files 
in the Enterprise Integration directory.

Click Next.

 11 Click Finish to close the HP Quality Process for SAP Solutions Uninstall 
dialog box.
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Chapter 1 • Setting Up Enterprise Integration
Uninstalling Enterprise Integration from Linux or Solaris
This section describes how to uninstall Enterprise Integration from Linux or 
Solaris.

To uninstall Enterprise Integration from Linux or Solaris:

 1 Make sure that the application server is running.

 2 Type the following command at the system prompt:

/[directory]/[Enterprise Integration_directory]/_uninst/uninstall.bin

The HP Quality Process for SAP Solutions Uninstall wizard opens.

 3 Click Next. Follow the on-screen instructions.

 4 Run the Quality Center Archive and Deployment Tool to create a new 
archive and redeploy the Quality Center and Site Administration .war files 
on the application server.

 5 When you are prompted to delete all add-in files, select Yes.
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2
The Enterprise Integration Workflow

This chapter provides an overview of using Enterprise Integration to export 
SAP Solution Manager business blueprints to Quality Center and to update 
Solution Manager with Quality Center test results.

Working with Enterprise Integration includes the following stages. 

Create 
Quality Center Project

Create 
Business Blueprint

Add and Edit Content 
for Business Blueprint

Export
 Business Blueprint to 

Quality Center

Assign Tests to 
Imported 

Requirements 

Run Assigned Tests

Update
Solution Manager 
37



Chapter 2 • The Enterprise Integration Workflow
Creating Quality Center Projects

You first create a project in Quality Center in which to test the SAP business 
blueprint. For more information on creating Quality Center projects, refer 
to the HP Quality Center Administrator’s Guide.

You must create the project on a Quality Center server for which Enterprise 
Integration is installed and for which you have an Enterprise Integration 
license. You must also enable the project you create for working with 
Enterprise Integration. For more information on installing and enabling 
Enterprise Integration, see “Installing Solution Manager Blueprint 
Integration” on page 11.

Creating Business Blueprints

In addition to creating a project in Quality Center, you create a business 
blueprint for a Solution Manager project. You associate the Solution 
Manager project with the Quality Center project you created by choosing 
Edit > Connection to HP Quality Center from Solution Manager. You can 
associate each Solution Manager project with only one Quality Center 
project and must connect to Quality Center with a user that has permissions 
to export business blueprints. For more information on setting 
Quality Center permissions for Enterprise Integration, see “Customizing 
User Group Permissions for the Integration with Solution Manager” on 
page 70.

For more information on creating Solution Manager business blueprints, see 
the SAP Extended Help.
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Chapter 2 • The Enterprise Integration Workflow
Adding and Editing Business Blueprint Content

After you create the business blueprint in Solution Manager, you add 
content as you would to a regular business blueprint, using the SOLAR01 
transaction. You must also add requirements in the Quality Prerequisites tab 
to the blueprint elements you want to be exported to Quality Center. Only 
blueprint elements that contain requirements are exported to 
Quality Center.

Note: You can also use the SOLAR02 transaction to manage and export 
business blueprints.

Exporting Business Blueprints to Quality Center

After you have added content to your business blueprint, you export it to 
the Quality Center Requirements module. You export the content by 
choosing Business Blueprint > Send data to Quality Center in the SOLAR01 
transaction. The blueprint’s data is exported to Quality Center as 
requirements and requirement fields. For more information on how 
business blueprint data is exported into Quality Center, see “Exporting the 
Solution Manager Business Blueprints” on page 41.

Assigning Tests to Exported Requirements

For each business requirement exported to Quality Center, you can create 
testing requirements for testing specific functionality of the business 
requirements. In the Quality Center Test Plan module, you then design tests 
to cover these testing requirements or to cover testing requirements created 
automatically as part of the blueprint export process. You can then create 
coverage between these tests and the testing requirements. For more 
information on designing tests in Quality Center and associating tests with 
requirements, see the HP Quality Center User’s Guide.
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Chapter 2 • The Enterprise Integration Workflow
Running Assigned Tests

After you design tests to cover your requirements, you create test sets folders 
and test sets in the Quality Center Test Lab module. You then create 
instances of the tests you created and assign them to these test sets. You 
then run the test instances in the tests sets. For more information on 
creating test sets and running tests, see the HP Quality Center User’s Guide.

Update Solution Manager

After you run the test instances associated with the requirements exported 
from your business blueprint, you can export the results to Solution 
Manager. For each requirement in Solution Manager, you can view the tests 
instances associated with it in Quality Center and their status. For more 
information on exporting tests to Solution Manager, see “Updating Business 
Blueprints” on page 45.

You view this information from the SOLAR_EVAL transaction under Analysis 
> Projects > Testing with SAP Quality Center by HP > Test Results for 
Business Test Requirements. Alternatively, you can view the information for 
a specific requirement from the SOLAR01 transaction by selecting the 
requirement and clicking the Test Results tab of the properties window. For 
more information on viewing exported results in Solution Manager, refer to 
the SAP Extended Help.

After you have updated Solution Manager, you can modify the business 
blueprint in accordance with your test results and repeat the integration 
process.
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Working with Enterprise Integration

After you have created your Quality Center and Solution Manager projects 
and added content to your Solution Manager business blueprint, you can 
export the business blueprint to the Quality Center Requirements module. 
You can associate the exported requirements with tests and run the tests in 
Quality Center, and then update the tests and their results in Solution 
Manager.

Exporting the Solution Manager Business Blueprints

You can use Enterprise Integration to export your SAP Solution Manager 
business blueprints to Quality Center as requirements in the Requirements 
module. This is useful when you want to create and run tests based on the 
business blueprint structure. You export business blueprints from the 
Business Blueprint menu in the SOLAR01 SAP transaction. For more 
information, see the SAP Extended Help.

Note: Only blueprint structure elements containing at least one 
requirement can be exported from Solution Manager.

This chapter describes: On page:

Exporting the Solution Manager Business Blueprints 41

Updating Business Blueprints 45
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Chapter 3 • Working with Enterprise Integration
When you export the business blueprint for an SAP Solution Manager 
project, elements in the blueprint are mapped to requirements and fields in 
the Quality Center Requirements module, according to the following rules:

➤ The blueprint structure is mapped to the Quality Center requirements 
hierarchy. The blueprint title is mapped to a requirement of type Folder 
created under the requirement Solution Manager Blueprints, itself created 
under the root requirement. The name of the requirement is the same as the 
title of the root element. All child elements of the root element are mapped 
as child requirements of this requirement of type Folder.

➤ General documentation and project documentation are mapped to 
attachments of type URL that link to the documentation on the Solution 
Manager server.

➤ Solution Manager requirements are mapped as Quality Center requirements 
of type Business.

➤ Transactions and other testing objects are mapped as child requirements of 
the requirement representing the blueprint element under which they are 
located, of type Testing.

➤ The test object ID of a blueprint element is mapped to the Name field of the 
requirement representing the element.

➤ Other blueprint element attributes and administrative keywords are mapped 
to the following Quality Center requirement fields described in the table 
below. These fields are created automatically when you enable the 
Enterprise Integration extension and are read-only.

Fields Description

SM Keywords A list of the keyword associated with the business 
blueprint element, separated by semicolons (;).

SM Logical 
Component

The name of the Solution Manager logical component. 
This field has a value only for requirements of type 
Business representing Solution Manager requirements.
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When you export a business blueprint that has already been exported, 
Enterprise Integration does not create new requirements in Quality Center. 
Instead, the existing requirements in Quality Center are updated. Note the 
following:

➤ Any changes that you made to the structure previously exported from 
Solution Manager are overwritten. For example, suppose you exported a 
business blueprint structure to Quality Center requirements and 
subsequently renamed and moved some of these requirements. When you 
export the business blueprint again, the requirements’ original names and 
locations are restored. It is recommended that you do not make changes to 
data exported from Solution Manager.

➤ Any changes you made to requirement fields that were not exported from 
Solution Manager are preserved, in addition to associations with tests or 
child requirements. For example, if you change the Priority field for a 
requirement, the changes you made are not overwritten.

➤ If you export a business blueprint element to Quality Center and then delete 
the element in Solution Manager, when you export the business blueprint 
again, the requirement corresponding to the element is moved to the 
Solution Manager Blueprints trash folder. Any data under the requirement is 
also moved to this folder.

SM Object Code The Solution Manager object code. This field has a value 
only for requirements of type Business representing 
Solution Manager requirements.

SM Object Type The type of Solution Manager object. This field has a 
value only for requirements of type Business representing 
Solution Manager requirements.

Fields Description
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Business Blueprint Export Example

Consider the business blueprint structure below. Suppose the only 
requirement in the structure belongs to the process Process 1, and is named 
Requirement for Process 1.

After you export the blueprint structure to Quality Center, the requirements 
tree looks as follows: 

The blueprint structure root element test is exported as a child requirement 
of the requirement Solution Manager Blueprints. The elements Business 
Scenarios, Test scenario, Business Processes, and Process 1 are exported as 
child requirements of the requirement test. All these requirements are of 
type Folder. The Solution Manager requirement Requirement for Process 1 is 
exported as a Quality Center requirement of the same name and of type 
Business. Note that the elements Organizational Units and Master Data are 
not exported as they do not contain any requirements.
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Updating Business Blueprints

You can update your Solution Manager business blueprints from 
Quality Center. When you update a business blueprint, Quality Center 
sends information about runs of tests associated with requirements that 
represent business blueprint elements.

To update a business blueprint:

 1 Click the Tools button located on the upper right side of the Quality Center 
window and choose SPI Tools > Update Solution Manager. The Update 
Solution Manager dialog box opens.
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The Update Solution Manager dialog box displays the business blueprints 
previously exported to Quality Center. For each business blueprint, the 
following columns are displayed:

 2 Select the blueprint you want to update and click the Update Blueprint 
Quality button. The Blueprint Update Options dialog box opens.

Fields Description

Blueprint Title The title of the business blueprint.

Blueprint App ID The SAP application ID of the business blueprint.

Last Update The time the business blueprint was last successfully 
updated from Quality Center.

Status The Solution Manager update status. Can have one of the 
following values:

➤ New. The business blueprint was not previously 
updated from Quality Center.

➤ In Progress. Enterprise Integration is currently 
updating the business blueprint.

➤ No Run. No changes were made in the previous 
business blueprint update.

➤ Passed. The business blueprint was successfully 
updated with changes.

➤ Failed. Errors occurred during the previous business 
blueprint update.
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 3 Select one of the following options for updating the business blueprint:

➤ Typical. Sends to Solution Manager only information related to the 
blueprint that you are updating and that was added or updated since the 
previous successful update.

➤ Complete. Sends to Solution Manager all the test coverage and test 
execution information related to the blueprint you are updating. If you 
choose this option, updating the business blueprint may take some time. 
It is recommended that you do not use this option on a regular basis.

 4 Click OK. Enterprise Integration sends the test results to Solution Manager 
according the option you specified.

You can view this information from the SOLAR_EVAL transaction under 
Analysis > Projects > Testing with SAP Quality Center by HP > Test Results 
for Business Test Requirements. Alternatively, you can view the information 
for a specific requirement from the SOLAR01 transaction by selecting the 
requirement and clicking the Test Results tab of the properties window. For 
more information, refer to the SAP Extended Help.
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Blueprint Update Example

Consider the business blueprint exported in “Business Blueprint Export 
Example” on page 44. Suppose you create a requirement of type Testing to 
test the requirement of type Business Requirement for Process 1. You create 
a test Test 1 to test this requirement and assign it to the requirement. You 
then assign an instance of this test to a test set and run the test, which 
passes successfully.

When you update the business blueprint, the test associated with the 
requirement is displayed in Solution Manager. You can see the status of the 
test in the Test State column.
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Working with the Application Model 
Module

The Application Model module enables you to manage a hierarchical 
representation of the entities in your SAP application. You can import 
entities from your SAP application, and add and modify application entities 
and folders. You can also associate application entities with tests or business 
components. The Application Model module is automatically enabled when 
you enable Enterprise Integration for a Quality Center project.

This chapter describes: On page:

About Working with the Application Model Module 50

Viewing Application Entities 51

Importing the SAP Application Hierarchy 53

Adding Folders and Application Entities Manually 56

Modifying Folders and Application Entities 58

Associating Application Entities with Tests 60

Associating Application Entities with Business Components 64
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About Working with the Application Model Module

You use the Application Model module to manage a representation of your 
SAP application components and entities. For example, if you link your SAP 
application components and application entities to tests, you can see which 
tests you need to run when changes affecting these components and entities 
are made in your application.

You can import SAP components and application entities from your SAP 
application. When you import directly from your SAP application, the 
hierarchy of the components in the application and the basic data for each 
business entity are preserved. If you want to extend the scope at any stage, 
you can import the application hierarchy again, without overwriting 
existing entities in the Application Model module.  

You can also manually add and modify application entities in the 
Application Model module. Note that this does not affect corresponding 
application entities in your SAP application.

After you develop your application model tree, you can associate each 
application entity with tests in the Test Plan module. If your Quality Center 
server is licensed for Business Process Testing, you can also associate an 
application entity with a business component. Each business process test 
containing that business component is then associated with all of the 
application entities associated with that component. 
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Viewing Application Entities

You import, add, and modify application entities using the Application 
Model module. To open the Application Model module, click the 
Application Model button on the sidebar. 

You can view your application entities in the application model tree or the 
Application Model Grid.

The Application Model Tree
You can view a hierarchical representation of your application entities in the 
application model tree. To view the application model tree, choose View > 
Application Model Tree.

Each folder  in the application model tree represents an SAP application 
component in your SAP application. Each application entity  represents 
an application entity in your SAP application.
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The Application Model Grid
You can view all the application entities in a Quality Center project from the 
Application Model Grid. Each row displays a separate application entity. 
Each column represents a separate data item. To view the Application Model 
Grid, choose View > Application Model Grid. 

The following columns are displayed for each entity:

Column Description

Application The SAP application in which the application entity is 
located.

Code The code of the entity in the SAP application.

Description The description of the entity in the SAP application.

Entity ID A unique numerical ID assigned by Quality Center to the 
application entity. This ID cannot be modified.

Entity Name The name of the entity in the SAP application.

Folder The folder in the application model tree in which the 
application entity is located. Each folder represents an 
SAP application component. 
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Importing the SAP Application Hierarchy

You can import the application hierarchy to the Application Model module. 
This maps the entities in your SAP application to application entities in the 
Application Model module, reproducing the same hierarchical structure. 
Each SAP application component is represented as a folder. Each folder 
contains representations of the application entities that are included in the 
SAP application component in your SAP application. 

You can import the application hierarchy more than once. For example, if 
you add new entities to your SAP application, you may want to include 
them in the application hierarchy, or you may decide to include application 
entities that were previously out of scope. When you import application 
entities that are already in the Application Model module, the data that you 
entered for each application entity is preserved. Any associations you 
created with tests and business components are also preserved.

Is Active This column is relevant only for change impact testing. 

Modified The date and time when the application entity was last 
modified.

Type The type of SAP application entity, for example, SAP 
Transaction. 

Column Description
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To import the application hierarchy:

 1 In the Application Model module, display the application model tree and 
choose Application Entities > Import Application Model. The SAP Login 
Details dialog box opens.

 2 Type the login details for your SAP application and click Next. 
Quality Center connects to your SAP application and the Select Application 
Components dialog box opens, displaying the SAP components in your SAP 
application. (You can view the same hierarchy in your SAP application using 
the SE81 transaction.)
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 3 Select the SAP application components you want to import to the 
Application Model module. When these application components are 
imported, all child application entities are also imported. Click Next.

Note: You can also import user transactions that are not assigned to any 
application component. To import these transactions, select the User 
Transactions (Unassigned) node in the Select Application Components 
dialog box.

 4 Click Import to import the SAP components and application entities to the 
Application Model module. Note that this process may take some time. 
When the import process is finished, a confirmation message displays. Click 
OK.

 5 Click Close to close the Import Application Model Wizard.

The application components you selected are imported to the Application 
Model module. The hierarchical structure of the SAP application 
components is reproduced in the Application Model module, with the top 
level components located under the SAP folder.

When you import application entities to the Application Model module, a 
default values are assigned to various fields for each imported application 
entity. These default values are based on the properties of the entity in the 
SAP application. 

Adding Folders and Application Entities Manually

You can add folder and application entities manually.

Tip: You can also import folders and application entities using the SAP 
Import wizard. For more information, see “Importing the SAP Application 
Hierarchy” on page 53.
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To add a folder:

 1 In the application model tree, select a folder and click the New Folder 
button, or choose Application Entities > New Folder. The New Folder dialog 
box opens.

 2 In the Folder Name box, type a name for the folder and click OK. The new 
folder is added to the application model tree under the folder you selected 
in step 1.

 3 You can add a description for the new folder in the Description tab in the 
right pane.

 4 You can add an attachment to the new folder in the Attachments tab. For 
more information on adding attachments, see the HP Quality Center User’s 
Guide.
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To add an application entity:

 1 In the application model tree, select a folder and click the New Entity 
button, or choose Application Entities > New Entity. The New Application 
Entity dialog box opens.

 2 In the Application Entity Name box, type the name of the application entity. 
This is a required field.

 3 In the Application Entity Code box, type the unique code of the application 
entity. This is a required field.

 4 In the Description box, type a description of the application entity.

 5 Click OK. The new application entity is added to the application model tree 
under the folder you selected in step 1.
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Modifying Folders and Application Entities

You can rename and delete folders and application entities in the 
Application Model module.

Renaming Folders and Application Entities
You can rename a folder or application entity in the Application Model 
module.

To rename a folder or application entity:

➤ To rename a folder or application entity in the application model tree, select 
a folder or application entity and choose Edit > Rename. Alternatively, right-
click the folder or application entity and choose Rename. Edit the name and 
press ENTER.

➤ To rename an application entity in the Application Model Grid, click the 
name of the application entity and type the new name.

Deleting Folders and Application Entities
You can delete a folder or application entity from the application model 
tree. When you delete a folder, you can choose to delete the folder and its 
subfolders, or you can choose to delete the folder, its subfolders, and 
application entities. 

➤ If you delete a folder with its subfolders, all of the application entities are 
moved to the Unattached folder in the application model tree. 

➤ If you delete a folder with its subfolders and application entities, all 
subfolders and application entities under the selected folder are deleted 
permanently. 
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To delete a folder:

 1 Select a folder from the application model tree.

 2 Click the Delete button, or choose Edit > Delete. Alternatively, right-click 
the folder and choose Delete. The Confirm Delete Folder dialog box opens.

 3 Select Delete folders only or Delete folders and application entities.

 4 Click Yes.

To delete an application entity:

 1 Select an application entity from the application model tree or Application 
Model Grid.

 2 Click the Delete button, or choose Edit > Delete. Alternatively, right-click 
the application entity and choose Delete.

 3 Click Yes to confirm.
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Associating Application Entities with Tests 

You can associate the application entities you created in the Application 
Model module with tests from the Test Plan module. You can perform this 
task from the Application Model module or from the Test Plan module. 

Associating Application Entities with Tests Using the 
Application Model Module
You can associate application entities with tests using the Application Model 
module.

To associate application entities with tests using the Application Model 
module:

 1 In the application model tree, select an application entity and click the 
Linked Tests tab. The Linked Tests tab displays the coverage grid for the 
selected application entity.

For information on the columns in the Linked Tests tab, see the 
HP Quality Center User’s Guide.
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 2 In the Linked Tests tab, click the Select Tests button to show the test plan 
tree on the right.

 3 To search for a specific test in the tree, type the name (or part of the name) 
of the test in the Find box and click the Find button. If the search is 
successful, the test is highlighted in the tree.

 4 To refresh all of the tests in the test plan tree, click the Refresh All button.

 5 Select a test or test folder to add to the application entity’s test coverage. 
Click the Link Tests To Application Entity button. The test is added to the 
coverage grid.

 6 To refresh the application entities in the coverage grid, click the Refresh All 
button.

 7 To filter the application entities displayed in the coverage grid, choose one 
of the following options from the Show Entities box:

➤ Linked Directly. Displays only those tests that are associated directly with 
the application entity.

➤ Linked Through Other Assets. Displays only those tests that are 
associated with the application entity via business components.

➤ All. Displays all of the application entities that are associated with the 
test. 
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 8 Click the Close button to hide the test plan tree.

Notes: 

➤ To modify the data in the coverage grid columns or to remove tests from 
the coverage grid, you must first select Linked Directly in the Show 
Entities box.

➤ To remove test coverage from the Application Model module, verify that 
Linked Directly is displayed in the Show Entities box. Then select the test 
you want to remove from coverage and click the Remove Link button. 
Click Yes to confirm.

Associating Application Entities with Tests Using the Test 
Plan Module
You can associate application entities with tests using the Test Plan module.

To associate application entities with tests using the Test Plan module:

 1 In the test plan tree, select the test you want to associate with one or more 
entities, and click the Application Entities tab. The application entities 
associated with the selected test are displayed.
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 2 In the Application Entities tab, click the Select Application Entities button 
to show the application model tree on the right.

 3 To search for a specific application entity in the tree, type the name (or part 
of the name) of the application entity in the Find box and click the Find 
button. If the search is successful, the application entity is highlighted in 
the tree.

 4 To refresh all of the application entities in the application model tree, click 
the Refresh All button.

 5 Select an application entity or application folder to add to the test’s 
application entity coverage. Click the Add Entity to Linkage button. The 
application entity is added to the coverage grid.

 6 To refresh the application entities in the coverage grid, click the Refresh All 
button.

 7 To filter the application entities displayed in the coverage grid, choose one 
of the following options from the Show Entities box:

➤ Linked Directly. Displays only those application entities that are 
associated directly with the test.

➤ Linked Through Other Assets. Displays only those application entities 
that are associated with business components via business process 
tests.

➤ All. Displays all of the application entities that are associated with the 
test. 
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 8 Click the Close button to hide the application model tree.

Notes: 

➤ To modify the data in the coverage grid columns or to remove 
application entities from the coverage grid, you must first select Linked 
Directly in the Show Entities box.

➤ To remove application entity coverage from the Test Plan module, verify 
that Linked Directly is displayed in the Show Entities box. Then select the 
application entity you want to remove from coverage and click the 
Remove Link button. Click Yes to confirm.

Associating Application Entities with Business Components

You can associate an SAP entity with any type of test, including a business 
process test. To associate an entity with a business process test, you first 
associate the entity with one or more business components. Then, when 
you include these business components in a business process test, the test is 
automatically associated with the entities that are a part of the business 
process test’s business components. For details on adding business 
components to a business process test, see the HP Business Process Testing 
User’s Guide.

You associate application entities with business components using the 
Business Components module. After they are associated, you can manage 
your associated application entities either from the Application Model 
module or from the Business Components module.

To associate application entities with business components:

 1 In the component tree, select the component you want to associate with 
one or more application entities, and click the Application Entities tab. The 
application entities associated with the selected business component are 
displayed. For a description of each column displayed, see “The Application 
Model Grid” on page 52.
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 2 In the Application Entities tab, click the Select Application Entities button 
to show the application model tree on the right.

 3 To search for a specific application entity in the tree, type the name (or part 
of the name) of the application entity in the Find box and click the Find 
button. If the search is successful, the application entity is highlighted in 
the tree.

 4 To refresh all of the application entities in the application model tree, click 
the Refresh All button.

 5 Select an application entity or application folder to add to the business 
component’s application entity coverage. Click the Add Entity to Linkage 
button. The test is added to the coverage grid.

 6 Click the Close button to hide the application model tree.

Note: To remove application entity associations from the Business 
Components module, select the application entity for which you want to 
remove an association, click the Remove Link button, and click Yes to 
confirm.
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5
Customizing Enterprise Integration

You can customize user group permissions, hide data for a user group and 
customize project entities for Enterprise Integration.

About Customizing Enterprise Integration

You can customize entities in the Application Model module, which is 
enabled automatically when you enable Enterprise Integration. You 
customize these entities in the same way as you customize other entities in 
your Quality Center projects. You can restrict which user groups can add, 
delete and modify folders and application entities. You can also determine 
which application entities and application entity fields each user group can 
view. In addition, you can add and customize Application Model fields.

You can also customize which Quality Center user groups can export 
business blueprints from Solution manager, and which user groups can 
update business blueprints.

This chapter describes the additional customization options available with 
Enterprise Integration. For more information on project customization, refer 
to the HP Quality Center Administrator’s Guide.

This chapter describes: On page:

About Customizing Enterprise Integration 67

Customizing User Group Permissions 68

Hiding Data for a User Group 71

Customizing Project Entities 72
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Customizing User Group Permissions

You can customize the permission settings for the Application Model 
module and for the integration with Solution Manager in the Permission 
Settings dialog box in Project Customization. For more information on user 
group permissions, refer to the HP Quality Center Administrator’s Guide.

Customizing User Group Permissions for the Application 
Model Module
The Application Model tab displays the tasks available in the Application 
Model module. 
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The Application Model tab includes the following tasks:

Task Description

Add Application Entity User group can add application entities to the 
Application Model module. A user group must have 
permissions for this task and for the Modify 
Application Entity task to import SAP application 
entities.

Modify Application Entity User group can modify application entities in the 
Application Model module. Note that this task 
enables you to specify the fields that the selected 
user group can modify. A user group must have 
permissions for this task and for the Add 
Application Entity task to import SAP application 
entities.

Delete Application Entity User group can delete application entities from the 
Application Model module.

Move Application Entity User group can move application entities in the 
Application Model module.

Add Folder User group can add folders to the Application Model 
Tree.

Modify Folder User group can modify folders in the Application 
Model Tree. Note that this task enables you to 
specify the fields that the selected user group can 
modify.

Delete Folder User group can delete folders from the Application 
Model Tree.

Move Folder User group can move folders in the Application 
Model Tree.

Add Link to Asset User group can associate application entities with 
tests and business components.

Delete Link from Asset User group can remove association of application 
entities with tests and business components.
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Customizing User Group Permissions for the Integration 
with Solution Manager
The Blueprint tab displays the tasks available for the integration with 
Solution Manager. 

The Blueprint tab includes the following tasks:

Task Description

Push Blueprint User group can connect to Quality Center from 
Solution Manager and export business blueprints. 

Update Blueprint Quality User group can update Solution Manager with 
Quality Center test results.
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Hiding Data for a User Group

You can instruct Quality Center to hide specific application entities and 
application entity fields that a user group can view in the Application Model 
module.

You can set filters for specific fields, limiting the application entities that the 
user group can view. For example, you can set the filter for the field Type to 
SAP Batch Job. This instructs Quality Center to allow users belonging to the 
user group to view only application entities that are SAP batch jobs. You set 
filters in the Filter Condition tab in the Application Model Data-Hiding 
Filter dialog box. For more information on hiding data for a user group, refer 
to the HP Quality Center Administrator’s Guide.

You can filter by the following fields: Application, Code, Entity ID, Entity 
Name, Folder, Is Active, Modified, and Type. For more details on these fields, 
see “The Application Model Grid” on page 52.
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You can also select which fields in the Application Model module the user 
group can see and which should be hidden. You select these fields in the 
Visible Fields tab in the Application Model Data-Hiding Filter dialog box.

You can choose to hide the following fields: Application, Description, 
Folder, Is Active, Modified, and Type. For more details on these fields, see 
“The Application Model Grid” on page 52.

Customizing Project Entities

You can customize the system fields and add new user-defined fields for the 
Application Model module from the Customize Project Entities dialog box. 
You customize these fields under the Application Entity entity. For more 
information on customizing project entities, refer to the HP Quality Center 
Administrator’s Guide.
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